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A. Microscopy: Does your protocol involve video microscopy? N
B. Does your protocol include software usage? Y 
If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps.

C. Which steps of your protocol will viewers benefit most from having filmed? 2.8., 3.2.2., 4.2., 4.5., 4.6., 
D. What is the single most difficult aspect of this procedure and what do you do to ensure success?  4.5, 4.6.
E. Will the filming need to take place in multiple locations? N
1. Introduction (Experimental Goal and Author Interviews) – As the beginning of your video, the introduction should clearly present the goal of your method to the viewer and its significance.  Other information can be provided according to the various statements below, but the total introduction should not exceed 150 words. 
A. Experimental Goal: (read by voice talent at JoVE)
The overall goals of this experiment are to apply mechanical loading in an erosive environment to mimic the clinical dental wear process and to use non-contact profilometry for visualization and measurement of the resulting wear pattern. (Intro)
B.  Required Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.1. Jan Ruben: This method can help answer key questions about the etiology and prevention of erosive tooth wear, such as which factors influence erosive tooth wear and how do they interact? 
1.2. Jan Ruben: The main advantage of this technique is that it facilitates simulation of the clinical interplay between chemical and mechanical wear processes.  

C.  Optional Interview Statements: (Said by you on camera. Don’t forget to smile!)  
1.3. Bas Loomans: Though this method can provide insight into the etiology and pathogenesis of tooth wear it can also be applied to other systems, such as fatigue and wear of dental restoration. 
D. Introduction of Demonstrator: (Said by you on camera. Don’t forget to smile!)
E.  Ethics title card: (for human subjects or animal work, does not count toward word length total)
1.4. Procedures involving human subjects have been approved by the Regional Medical Ethics Committee at Radboud University Medical Center.
Protocol: (read by voice talent at JoVE)
2. Specimen Preparation
2.1. Begin by using a low-speed handpiece to brush twenty-four sound, extracted human molars with pumice until no debris or gingival remnants remain [1-WIDE].

2.1.1. Few seconds Talent brushing at least one tooth

2.2. When all of the teeth have a smooth surface [1-ECU], rinse each specimen for 15 seconds under running tap water [2-MED].

2.2.1. Shot of smooth tooth/teeth in Talent’s hand or on bench or similar

2.2.2. Few seconds Talent rinsing at least one teeth

2.3. Next, melt one 113-gram stick of impression compound on a 50 °C hotplate for approximately 10 minutes [1-CU] and dip the occlusal end of the first molar into the molten substance until the entire occlusal surface is covered [2-ECU].
2.3.1. Few seconds compound melting on hot plate

2.3.2. Few seconds tooth being dipped/occlusal surface being covered

2.4. Place the molar upside down on a glass microscope slide [1-CU] and press down until all of the cup tips touch the glass [2-ECU].

2.4.1. Few seconds tooth being placed Author comment: Take 2.4.1 starting 0 seconds and end 16 seconds. 

2.5 Hold the tooth in place for about 30 seconds until the impression compound has cooled and set, fixing the tooth [1-CU-TXT]

2.5.1 
Last few seconds tooth being pressed, then shot of fixed tooth (TEXT: Repeat for each molar Author: Use 2.4.1 starting at 16 seconds until the end

2.4.2. Shot of all tips touching class/tooth being pressed

2.5. Hold the tooth in place for about 30 seconds until the impression compound has cooled and set, fixing the tooth [1-CU-TXT].

2.5.1. Last few seconds tooth being pressed, then shot of fixed tooth (TEXT: Repeat for each molar)
2.6. When all of the molars have been set, use a syringe to dispense 10 mL of polymethylmethacrylate, or PMMA (Pronounce: P-M-M-A), mixture into one 12 x 15 x 27.5 mm silicone mold per tooth [1-MED-over the shoulder-TXT] and suspend each molar upside down in the PMMA, pressing the slides down until they touch the molds [2-CU].
2.6.1. Few seconds Talent adding PMMA to mold (TEXT: See text for all reagent preparation details)

2.6.2. Tooth being suspended in PMMA/slide being pressed 
2.7. When all of the samples have been immersed, allow the PMMA to set at room temperature and 1000 hectopascals [1-MED].
2.7.1. Talent placing samples at RT and 1000 hPa to set 
2.8. After 20 minutes, remove the teeth from the molds [1-CU] and use a milling machine equipped with a 16-mm milling cutter to adjust the height of each sample to exactly 27.3 mm [2-ECU].
2.8.1. Few seconds tooth being removed from mold Author comment: Use take 4
2.8.2. Few seconds tooth being milled

3. Profilometric Scanning, Analysis, and Subtraction
3.1. To scan the specimens, turn on the profilometer equipment [1-WIDE] and secure the appropriate sensor with a thumbscrew [2-MED].
3.1.1. Talent turning on equipment
3.1.2. Few seconds Talent securing sensor in place
3.2. Carefully insert the optical fiber in the sensor controller [1-CU] and select the correct sensor on the sensor controller [2-MED].
3.2.1. Few seconds fiber being inserted Author comment: Use 3.1.2 take 2
3.2.2. Few seconds Talent selecting sensor 
3.3. Press F4 twice to display the confocal sensor menu [1-CU]. Then press F3 and scroll to 2-10,000 micrometers [2-CU].
3.3.1. F4 being pressed twice/sensor menu being displayed
3.3.2. F3 being pressed then few seconds scrolling to 2-10,000 micrometers
3.4. Select 10 mm and press F4 [1-CU].
3.4.1. 10 mm being selected and F4 being pressed
3.5. Press F1 and select F4 to save the settings to memory [1-CU]. Then select “LED intensity” and adjust the position to "± 9 o’clock" [2-CU].
3.5.1. F1 and F4 being pressed

3.5.2. LED intensity being selected, the position being adjusted 
3.6. Press F4, then F2, then F4 again to obtain a "dark reference" of the sensor [1-CU].
3.6.1. F4, F2 then F4 being pressed
3.7. Next, open the software [1-MED-over the shoulder] and “connect” to the device. The measuring table will automatically move to the "home position" search [2-SCREEN].
3.7.1. Talent at computer, opening software 
3.7.2. *To be provided by Authors: Device being connected, and table appearing and being moved to home position
3.8. Under the Tools menu, click sensor selection. Then set “Sensor S29” to 10-10,000 micrometers [1-SCREEN].
3.8.1. *To be provided by Authors: Sensor selection being clicked, the Sensor S29 being set to 10-10,000 micrometers
3.9. Set the “sample rate” to 300 Hz and the “speed sensor” to 0-100% [1-SCREEN].
3.9.1. Sample rate being set to 300 Hz and speed sensor being set to 0-100% 
3.10. Under Scan, select “Key Move Stage” and select the yellow area in the middle of the screen to move the measuring table to the center of the viewing area [1-SCREEN].
3.10.1.  Key Move Stage being selected, then yellow area being selected/table being moved to center of viewing area 
3.11. Position the specimen of interest within the center of the measuring table [1-MED] and set the correct height within the range of the sensor [2-CU].
3.11.1.  Few seconds Talent positioning specimen
3.11.2.  Few seconds height being set 
3.12. Place the sensor above the area of interest on the specimen [1-MED] and adjust the distance of the sensor until the complete sample area to be scanned is located within the focus range of the sensor [2-CU].
3.12.1.  Few seconds Talent placing sensor
3.12.2.  Few seconds distance being adjusted/sample area being adjusted to range of sensor
3.13. When the height is within the range of the sensor, the sensor controller will display a green area in the live data height [1-CU].
3.13.1. Green display appearing in live data height
3.14. Under Settings, set the average to 2 to ensure that each recorded data point is the average of 2 measurements [1-MED-TXT].
3.14.1. Talent at computer, setting average to 2 (TEXT: Scan speed will slow/quality will increase)
3.15. Click OK to return to the main scanning setup and position the sensor beam on the upper left corner of the specimen [1-SCREEN].
3.15.1.  *To be provided by Authors: Ok being clicked, then few seconds sensor beam being positioned 
3.16. Set the total scan area to 15 x 12 mm with a step size of 40 micrometers in the X and Y directions and click scan to begin the scanning, saving the file when the scan is over [1-SCREEN-TXT].
3.16.1.  *To be provided by Authors: Few seconds scan area being set (TEXT: i.e. X = 375 steps; Y = 300 steps), then scan being clicked/scanning being started, then file being saved
3.17. To analyze the scanned files, under the Warpage menu, apply a warpage filter of 1 to eliminate the noise of the scanning table and sensor and select the “highest point” menu to find the highest point on the molar [1-SCREEN].
3.17.1.  *To be provided by Authors: Warpage menu being opened, then few seconds filter being applied, then highest point menu being selected/highest point being found 
3.18. Under Tools, select “option-scale” for the scan configuration and set the offset in millimeters as calculated by the Z value of the highest point minus 3500. Set the Range from 0-3.6 mm and click OK [1-SCREEN].

3.18.1.  *To be provided by Authors: Option scale being selected, then offset being set, then range being set, then OK being clicked 
3.19. Then open the Load Area menu bar to reset the scale and save the file [1-SCREEN].
3.19.1.  *To be provided by Authors: Load Area menu being opened and scale being reset, then file being saved
3.20. For profilometric subtraction of the scanned data, open the original and modified scan files and select “manual leveling” for the original scan file and “offset” for the modified scan file [1-SCREEN].
3.20.1.   *To be provided by Authors: Few seconds files being opened/shot of open files, then manual leveling and offset being selected/set
3.21. Under the Window menu, select Create View and Cross Section [1-SCREEN].
3.21.1. *To be provided by Authors: Create view being selected, then cross section being selected
3.22. Select the modified scan file surface and use the control and arrow keys to move the modified file surface over the surface of the original file until the subtracted volume and height appear in the difference view and are as low as possible [1-SCREEN-TXT].
3.22.1. *To be provided by Authors: Modified scan file surface being selected, then few seconds modified surface being moved onto original file surface (TEXT: Output is read as mean volume and height loss)
4. Sample Mounting and Rub&Roll Machine Preparation
4.1. When all of the molars have been scanned, remove the cylinder from the Rub and Roll machine container [1-WIDE] and place the molars into the cylinder recesses [2-MED-over the shoulder].

4.1.1. Few seconds Talent removing cylinder
4.1.1.1 Added shot: disassemble cylinder
4.1.2. Few seconds molars being placed

4.2. To adjust the loading force, place a 1 mm shim in the recess underneath eight specimens [1-CU-TXT] and a 1.5 mm shim under a second set of eight specimens [2-CU-TXT], leaving the last set of 8 specimens load free [3-ECU-TXT].
4.2.1. Few seconds 1 mm shim being placed (TEXT: i.e. 30 N load force)
4.2.2. Few seconds 1.5 mm shim being placed (TEXT: i.e. 50 N load force)
4.2.3. Shot of 8 specimens w/o shim (TEXT: i.e. 0 N load force)
4.2.4. Added shot: Place rubber band around the cylinder
4.3. Next, mount the two halves of the cylinder [1-MED] and secure the cylinder with a M6 bolt [2-CU].
4.3.1. Few seconds Talent mounting cylinder

4.3.2. Few seconds bolt being secured
4.4. Place the cylinder back into the container [1-MED] and fill the container with 500 mL of demineralization solution [2-CU].
4.4.1. Few seconds Talent placing cylinder

4.4.2. Few seconds container being filled
4.5. Insert the loading rod [1-CU-TXT] and set the rotation speed to 20 rpm to simulate a relevant clinical chewing frequency [2-MED-TXT].
4.5.1. Few seconds rod being inserted (TEXT: See text for loading rod material/diameter details)

4.5.2. Few seconds Talent setting rotation speed and switching the motor on TEXT: Allow Rub and Roll to run for 3-4 days
4.6. Without interrupting the rotation, replace the demineralization solution and loading tube [1-MED] and use a calibrated glass electrode to check the pH twice a week [2-CU].
4.6.1. Few seconds Talent replacing solution and/or tube

4.6.2. Few seconds pH being checked, with readout of pH level visible in frame if possible

4.7. After 3 months, disconnect the cylinder from the container [1-MED-TXT] and disassemble the cylinder to remove the samples [2-MED-over the shoulder].

4.7.1. Few seconds cylinder being disconnected (TEXT: i.e. about 1,500,000 cycles)
4.7.2. Few seconds cylinder being disassembled

4.8. Then scan the specimens as just demonstrated [1-MED] and store them in deionized water [2-CU].
4.8.1. Talent placing specimen under sensor
4.8.2. Specimen(s) being placed into water
3.20 For profilometric subtraction of the scanned data, open the original and modified scan files and select “manual leveling” for the original scan file and “offset” for the modified scan file [1-SCREEN].
3.20.1 *To be provided by Authors: Few seconds files being opened/shot of open files, then manual leveling and offset being selected/set
3.21 Under the Window menu, select Create View and Cross Section [1-SCREEN].
3.21.1 *To be provided by Authors: Create view being selected, then cross section being selected
3.22 Select the modified scan file surface and use the control and arrow keys to move the modified file surface over the surface of the original file until the subtracted volume and height appear in the difference view and are as low as possible [1-SCREEN-TXT].
3.22.1 *To be provided by Authors: Modified scan file surface being selected, then few seconds modified surface being moved onto original file surface (TEXT: Output is read as mean volume and height loss)
5. Results: Representative Rub&Roll Molar Erosion and Analyses
5.1. Light microscopy reveals the presence of saucer shaped lesions on the occlusal cusp tips of molars exposed to 3 months of acidic aqueous solution under mechanical loading conditions in the Rub and Roll as just demonstrated [1-LM].
5.1.1. Authors: please upload the light microscopy images from Figure 3 together in their own .ai, .tif or .psd file through the submission link: please outline/indicate flat circular areas on teeth in middle and right images
5.2. This “cupping” closely resembles the clinical phenomenon associated with erosive tooth wear [1-LM] and is further apparent by color mapping after scanning with a non-contact profilometer as just demonstrated [2-LM].

5.2.1. Authors: please upload the scan images from Figure 3 together in their own .ai, .tif or .psd file through the submission link: please outline/indicate green and green with blue areas on teeth in middle and right images
5.2.2. Figure 3 scan: please indicate color map scale to right of image  
5.3. Indeed, profilometric scanning before [1-LM] and after exposure [2-LM] allows comparison of the differences in molar cusp tip erosion over time [3-LM] as well the quantification of the mean occlusal surface height loss for each sample under various mechanical load pressure conditions [4-LM].

5.3.1. Authors: please upload the profliometric scan images from the top row of Figure 4 together in their own .ai, .tif or .psd file through the submission link: no animation
5.3.2. Authors: please upload the profliometric scan images from the middle row of Figure 4 together in their own .ai, .tif or .psd file through the submission link: no animation
5.3.3. Authors: please upload the profliometric scan graphs from the bottom row of Figure 4 together in their own .ai, .tif or .psd file through the submission link: no animation
5.3.4. Figure2.pdf: no animation OR sequentially add/indicate 30N and 50N data bars
6. Conclusion (said by authors on camera):
6.1. Jan Ruben: Following this procedure, other processes may be investigated, such as the ageing of dental restorations or the development of caries lesions in mechanically loaded teeth.
6.2. Jan Ruben: After watching this video, you should have a good understanding of how to use the Rub&Roll for the mechanical and chemical loading of extracted human molars in a simulated chewing movement under controlled force, velocity, fluid and time conditions. 
Provided Media

Authors, Please list all images, movie files, or 3-D rendered animations that can be included in the video per editor’s request.  The step in the script/video where these images will be inserted should be specified.   For example:

0123_ Figure1.tif -  dual color imaging of tumor angiogenesis at 40X 

0123_ Figure2.tif -  dual color imaging of tumor angiogenesis at 100X

Formats:  For static images we prefer .tiff, .eps, Illustrator, Powerpoint or Photoshop files at dimensions of at least 720X480 pixels and 300 dpi.  The higher resolution, the better.  Likewise any exported movie files should have at minimum these dimensions and be rendered to .mov, .mp4, or .avi files.  

Insert the filenames of all the media to be included into the video here.
Figure2.pdf
General Preparation

It’s critical for a smooth and organized shoot that all reagents are accounted for, in advance.   

Any overnight or long incubation steps should be recognized and specimens/samples be prepared in advance so that prior steps can be recorded and shooting can continue with pre-prepared specimens/samples.  

All tubes/flasks should be pre-labeled neatly before we arrive.  

Ex. Luciferase assay done in 96 well plates should be labeled with negative/positive control wells and experimental samples are labeled accordingly.

You will receive more detailed preparation instructions in the email accompanying the finalized script.
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